CONTENTS

Foreword 5
Overview of asPECT 7
  Main Screen 8
  Material Screen 9
  Plants Screen 10
  Project Screen 11
  Constants Screen 12

Getting Started with the asPECT Software Tool 13
  Installation 13
  Running the Tool 13
  Saving and Opening Work 13
  Copy Protection 14

Material Screen Operations 15
  Creating a New Material 15
  Create from Production Energy 15
    Basic Data 15
    Electricity 16
    Other Fuel 17
    Water Usage 18
    Site Works 19
    Overburden Removal and Site Restoration 20
    All Consumables 20
  Create from CO₂e Figure 22

Plant Screen Operations 24
  Creating a New Plant 24
    Basic Data 24
    Electricity 25
    Other Fuel 25
    Water Usage 26
Figure 1 - Welcome screen

Foreword

The asPECT software and this user guide accompanies the protocol for calculating the life cycle greenhouse gases in asphalt\(^1\). The suite also includes the further guidance document which is designed to provide extra interpretation and justification of the clauses within the protocol and to demonstrate how applicable sections of the Publicly Available Specification for the Assessment of the Life Cycle Greenhouse Gas Emissions of Goods and Services (PAS 2050:2011; British Standards institution, 2011) have been followed. asPECT makes comprehensive use of Defra’s Government GHG Conversion Factors for Company Reporting (2013). The protocol, guidance document, this user guide and the software tool together constitute asPECT.

The software tool is designed to provide a framework which contains the necessary formulae, emissions factors and default data to calculate the ‘cradle-to-grave’ GHG emissions of asphalt products in accordance with the protocol clauses, covering the 10 steps of the asphalt life cycle indicated in Figure 2. It is designed primarily to be used by asphalt producers and contractors who have access to the detailed information that it requires to operate (which can easily be gathered through typical company accounting systems). The information generated by the

---

software is then passed onto client organisations in the pre-defined output formats which are built into the program.

<table>
<thead>
<tr>
<th>Life-cycle stage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Raw Material Acquisition</td>
<td>Acquiring raw materials from the natural environment with the input of energy</td>
</tr>
<tr>
<td>2 Raw Material Transport</td>
<td>Transporting acquired raw materials to processing</td>
</tr>
<tr>
<td>3 Raw Material Processing</td>
<td>Crude oil refining, rock crushing and grading, recycled and secondary material reprocessing</td>
</tr>
<tr>
<td>4 Processed Material Transport</td>
<td>Transporting processed raw materials to site of manufacture of bitumen bound highway components</td>
</tr>
<tr>
<td>5 Road Component Production</td>
<td>Production of bitumen bound mixtures</td>
</tr>
<tr>
<td>6 Material Transport to Site</td>
<td>Delivery of materials to site</td>
</tr>
<tr>
<td>7 Installation</td>
<td>Placing materials at the construction site, mobilisation of plant and labour</td>
</tr>
<tr>
<td>8 Scheme Specific Works</td>
<td>Installation of other specified materials direct to site (e.g. aggregates and geosystems)</td>
</tr>
<tr>
<td>9 Maintenance</td>
<td>Interventions to maintain the road: overlay, surface dressing works, patching, haunching etc.</td>
</tr>
<tr>
<td>10 End of Life</td>
<td>Excavation and material management, mobilisation of plant and labour</td>
</tr>
</tbody>
</table>

Figure 2- Ten step asphalt life cycle indicating scope

In 2013, a review of asPECT was commissioned. Part of the remit of this review was to update the software tool, with the following two objectives:

a) To add additional functionality to the asPECT software, in order to facilitate the use of non-UK specific emissions factors for international users, and those requiring a more customisable approach with regards to recycling-recyclability allocation and consideration of residual binder activity.

b) To update specific emissions factors for materials, fuels and transport in the software tool, where new and appropriate data sources have become available.

These two objectives have been met in producing the asPECT Software Tool version 3.1. Where applicable, updates have been added to this document to explain the additional functionality.
Overview of the asPECT Software Tool

Throughout this document, the latest version of the software is referred to, namely v3.1.

The tool centres around the following main elements:

- Main Screen;
- Materials Screen;
- Plants Screen; and the
- Project Screen.

All functions can be accessed through these main elements.

Also included are six categories of data:

- Material;
- Energy Consumption;
- Transport;
- Mixtures;
- Maintenance; and
- End of Life.

Although these data types are essentially independent entities, certain elements may contain parts of others e.g. End of Life data contains inputs from both Transport and Mixtures.
Main Screen

The Main Screen is the primary element of the tool from which all other elements are accessed. The main screen consists of a menu bar, toolbar, workspace and a status bar.

The menu bar contains 3 main menus:

- File;
- Windows; and
- Help.

For more information on the File menu, see section “Getting Started with the software tool”.

The File menu contains all the basic operations for the tool, such as creating a new file or opening and saving existing files.

The Window menu allows you to arrange the windows that you currently have open to make them easier to work with.

The Help menu allows you to access the ‘About’ screen which contains information regarding the software version, licence agreement and contact details for technical support.

The toolbar contains 4 buttons:

- Materials
- Plants
- Projects
- Constants

The Materials button opens the Materials main screen and provides an access point to create new and edit existing materials.

The Plants button opens the Plants main screen which displays details of all the plants entered into the tool. From here you have access to create new plants and edit existing ones.

The Projects button opens the Projects main screen which displays details of all saved projects in the software. From here you have access to create new projects and edit existing ones.

The Constants button opens a number of editable forms when using the software’s “open access” mode. From here you can specify your own constants for use in relation to a particular asPECT file.

Figure 3 – Toolbar icons
The status bar located along the bottom of the window contains a progress bar, to indicate the status of a file being opened or saved, and a link to the http://www.sustainabilityofhighways.org.uk website.
Materials Screen

The Materials screen is used to view the existing material data held in the software and to edit or add new materials.

The screen contains the following buttons: ‘Create from Production Energy’ and ‘Create from CO₂e Figure’.

A double left click with the mouse opens the selected material for editing. *Any changes made will be reflected immediately and cannot be undone.*

A right click with the mouse brings up the option to delete the selected material. *Please note, this action cannot be undone once selected.*

Default material data cannot be edited or deleted from the software. Updates to these may be made via updates released in the future by the asPECT development team.
Plants Screen

The Plants screen is used to view the existing asphalt plants held in the software and to edit or add new asphalt plants.

The screen contains a single button: ‘Add Plant’.

A double left click with the mouse opens the selected plant for editing. **Any changes made will be reflected immediately and cannot be undone.**

A right click with the mouse brings up the option to delete the selected Plant. **Please note, this action cannot be undone.**
Project Screen

The Projects screen is used to view the existing projects held in the software and to edit or add new projects.

The screen contains a single button: ‘Add Project’.

A double left click with the mouse opens the selected Project for editing. **Any changes made will be reflected immediately and cannot be undone.**

A right click with the mouse brings up the option to delete the selected Project. **Please note, this action cannot be undone.**
The constants editing screen can be accessed by clicking the Constants Icon when using the open access version of the software (when utilising .oaf files). Here the standard set of constants (or those that have been previously saved) can be overwritten and saved. The default constants can also be restored from this screen.
Getting Started with the asPECT Software Tool

Installation

The tool requires installation. To use the tool on your machine, follow the instructions on the installer, you will need administration rights to do this in Windows. This will install the software folder onto your PC.

Running the Tool

The program runs by double clicking the ‘AspectDesktop.exe’ file from the extracted folder.

Saving and Opening Work

Work undertaken in the tool can be saved in two types of file, with the extensions .acf and .oaf. If using .acf files then only the standard set of constants built into the tool can be used for the calculations, clicking the Constants icon from the main screen will alert the user to this. Constants can be edited if the ‘open access’ file type .oaf is selected when the file is saved.

To open and save your work:

The file can be named as you choose and does not have to be in the same folder as the software executable files.

Clients to whom asPECT data is being reported to should note the differentiation between the two file types, and consider the list of constants in addition to the final figures if .oaf files have been used in reporting.
Copy Protection

The asPECT software is free to use, subject to registration on the website. You are not free to distribute or to edit the software and code protection measures are taken within the software.

For further information please view the Licence Agreement (accepted on installation).
## Material Screen Operations

### Creating a New Material

The tool comes with preloaded default data including a range of materials (*asPECT Protocol document: Appendix D*). To complete a footprint of a mixture or a project you will need to add your own data, including raw materials. This can be done by entering the kgCO₂e/t for the material if known, or alternatively for aggregates it can be calculated from primary energy consumption from within the software.

### Create from Production Energy

To add a new material to the materials list by calculating the kgCO₂e/t from the production or input energy, select the ‘Create from Production Energy’ button.

The ‘Create from Production Energy’ screen is organised as a series of tabs along the top of the window. These tabs cover each section of data which is needed for a ‘cradle to gate’ CO₂e footprint to be calculated.

### Basic Data

This tab covers the initial information unique to the material, including the name and source. The material must be placed in a category which best describes it. The category list is provided in Table 1. Only materials that fall under the pre-existing material categories can be created from production energies, all other materials should be created from a ‘CO₂ figure’ (see next section).

#### Table 1 - Material categories available when created from production energy

<table>
<thead>
<tr>
<th>Crushed Rock</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ground Granulated Blast Furnace Slag (GGBS)</td>
</tr>
<tr>
<td>Incinerator Bottom Ash (IBA)</td>
</tr>
<tr>
<td>Limestone Filler</td>
</tr>
<tr>
<td>Pulverised Fuel Ash</td>
</tr>
<tr>
<td>Reclaimed Asphalt Planings (RAP)</td>
</tr>
<tr>
<td>Reclaimed Filler</td>
</tr>
<tr>
<td>Recycled Aggregate</td>
</tr>
<tr>
<td>Sand &amp; Gravel</td>
</tr>
<tr>
<td>Slag</td>
</tr>
<tr>
<td>Waste Glass</td>
</tr>
</tbody>
</table>

Please ensure that the correct ‘Category’ for the material is selected as this determines how the material is treated by the software and where in the software it is available for use.
If Reclaimed Asphalt Planings (RAP) is specified as the category, then an additional box requiring the Soluble Binder Content (%) of the RAP is activated. This information is needed by the software when calculating the recycled content discount and the future recyclability of asphalt mixtures.

**Electricity**

This tab allows the quantification of electricity used in the production of the material. Criteria for electricity usage which should be included in the material footprint is explained in the **Protocol Section 2.5.1.1** and some further explanation of the different types of electricity is provided in **Appendix A**. After selecting the electricity source and specifying an amount, clicking ‘Create’ adds the energy consumption to the material. If an error has been made, the quantity of electricity used can be edited by double clicking the ‘Amount’ column and entering the new kWh of electricity used. Alternatively, an entry can be removed by right clicking the row and selecting delete. Please note that this action cannot be undone.

- Select the ‘Source’ from the drop down list
- Enter the ‘Amount’ of electricity used annually
- Click ‘Add’ to associate these emissions with the material
Other Fuel

This tab allows other fuel use to be associated with the production of the material. The criterion for this fuel usage is again set out in Protocol Section 2.5.1.1 and some further explanation is provided in Appendix B. This tab operates in a similar fashion to the previous 'Electricity' tab.

Select the fuel to be added, select an appropriate unit (most common units of the fuels are included), enter the amount of fuel used and then click 'Create'. This associates the energy consumption to the specified material. If you make an error with the entry, the quantity of fuel used can be edited by double clicking the 'Amount' column and entering the new quantity. Alternatively an entry can be completely removed by right clicking the row and selecting delete. Please note that this action cannot be undone.

- Select the fuel type from the 'Source' drop down list
- Select the desired 'Unit' for the fuel being used
- Enter the 'Amount' of the fuel annually
- Click 'Add' to associate the emissions with the material

Figure 10 - Material electricity usage
Water usage (compulsory for primary aggregates, optional for other materials)

This tab allows the allocation of water usage in the production of the material. The criterion for this water usage is again set out in Protocol Section 2.5.1.1. This tab operates in a similar fashion to the previous ‘Electricity’ tab.

- Enter the ‘Amount’ of water used annually
- Click ‘Add’ to add the emissions to the material

As a minimum, at least one electricity source or one other fuel source must be specified to successfully create a material.
Site Works (compulsory for primary aggregates, optional for other materials)
This tab covers the usage of explosives in the quarrying of the material. Further details on explosive use are again set out in Protocol Section 2.5.1.1. Commonly used explosives are selected from the drop down menu and the quantity used in kg can be entered. Click ‘Create’ to add the explosive emissions to the material.
- Select the ‘Explosive’ from the ‘Source’ drop down list
- Enter the ‘Amount’ of explosive used annually
- Click ‘Add’ to add the emissions to the material
Overburden Removal and Site Restoration (compulsory for primary aggregates, optional for other materials)

These tabs allow the allocation of fuels used at the material production site for activities such as preparation for quarrying, excavation of overlying soil and restoration of the site at the end of operations. The requirement to quantify this fuel usage is again set out in Protocol Section 2.5.1.1. This tab operates in a similar fashion to the previous ‘Other Fuels’ tab. Select the fuel to be added, select an appropriate unit (most common units of the fuels are included), enter the amount of fuel used and then click ‘Add’ to save the energy consumption to the material.

- Select the ‘Source’ from the drop down list
- Select the desired ‘Unit’ for the fuel being used
- Enter the annualised ‘Amount’ of fuel used which can be attributed to the aggregate in question
- Click ‘Add’ to add the emissions to the material

![Figure 14 - Overburden removal](image)

All Consumables
The final tab on the Material Editor is for reviewing the consumables used in the creation of the material. It provides a summary and a quick look check that the correct values are being used to calculate the kgCO2e/t for the material being created.

- If any of the values need changing, select the appropriate tab for the entry and edit the value.
- If the emission sources are accurate, click ‘OK’ to save the new material to the database.
Figure 15 - Materials editor - all consumables

<table>
<thead>
<tr>
<th>Type</th>
<th>CO2s Source</th>
<th>Amount</th>
<th>Unit</th>
<th>kgCO2s</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electricity</td>
<td>UK Grid</td>
<td>1500</td>
<td>kWh</td>
<td>817.83</td>
<td>Site Works</td>
</tr>
<tr>
<td>Electricity</td>
<td>Renewable</td>
<td>200</td>
<td>kWh</td>
<td>0.00</td>
<td>Site Works</td>
</tr>
<tr>
<td>Fuel</td>
<td>Diesel</td>
<td>400</td>
<td>litres</td>
<td>1.271</td>
<td>Overburden</td>
</tr>
<tr>
<td>Fuel</td>
<td>Fuel Oil</td>
<td>100</td>
<td>tonnes</td>
<td>375.550</td>
<td>Site Works</td>
</tr>
<tr>
<td>Water</td>
<td>Water</td>
<td>3000</td>
<td>litres</td>
<td>0.90</td>
<td>Site Works</td>
</tr>
<tr>
<td>Explosives</td>
<td>ANFO</td>
<td>10</td>
<td>kg</td>
<td>40.67</td>
<td>Site Works</td>
</tr>
<tr>
<td>Fuel</td>
<td>Diesel</td>
<td>350</td>
<td>litres</td>
<td>1.112</td>
<td>Overburden</td>
</tr>
</tbody>
</table>

Save and close new material
Create from CO₂e Figure

Table 2 - Material categories available when entering a CO₂e figure

<table>
<thead>
<tr>
<th>Adhesion Agents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitumen</td>
</tr>
<tr>
<td>Bitumen – Polymer Modified (PMB)</td>
</tr>
<tr>
<td>Bitumen Emulsions</td>
</tr>
<tr>
<td>Bitumen Emulsions – Polymer Modified (PMBE)</td>
</tr>
<tr>
<td>Cement</td>
</tr>
<tr>
<td>Crushed Rock</td>
</tr>
<tr>
<td>Fibres</td>
</tr>
<tr>
<td>Fluxes</td>
</tr>
<tr>
<td>Ground Granulated Blast Furnace Slag (GGBS)</td>
</tr>
<tr>
<td>Hydrated Lime</td>
</tr>
<tr>
<td>Hydraulic Binders</td>
</tr>
<tr>
<td>Incinerator Bottom Ash (IBA)</td>
</tr>
<tr>
<td>Limestone Filler</td>
</tr>
<tr>
<td>Natural Bitumen</td>
</tr>
<tr>
<td>Other</td>
</tr>
<tr>
<td>Pigments</td>
</tr>
<tr>
<td>Pulverised Fuel Ash (PFA)</td>
</tr>
<tr>
<td>Reclaimed Asphalt Planings</td>
</tr>
<tr>
<td>Reclaimed Filler</td>
</tr>
<tr>
<td>Recycled Aggregate</td>
</tr>
<tr>
<td>Sand &amp; Gravel</td>
</tr>
<tr>
<td>Slag</td>
</tr>
<tr>
<td>Waste Glass</td>
</tr>
<tr>
<td>Waxes</td>
</tr>
</tbody>
</table>

To create a new material from a known kgCO₂e/t figure, sourced from either a published study or work conducted according to the Protocol Section 2.5.

- Enter a ‘Name’ for the material
- Select a ‘Category’ for the new material
- Enter a geographical ‘Source’ for the material
- Enter the ‘kg CO₂e/t’ figure
  - If ‘Reclaimed Asphalt Planings (RAP)’ is selected as the material category, the additional entry box for ‘Soluble binder content %’ must be completed
- Enter a description for the ‘Data Source’. This should be the details of where the material kgCO₂e/t figure being used comes from
- Select a ‘Valid from Date’ for your reference
- Click ‘OK’ to save the new material
Figure 16 - Create material from known emissions figure

A. Enter the desired name for the Material

B. Select the material Category

C. Enter the Source for the material

D. Enter the kgCO₂e/t figure for the material

E. Enter soluble binder content if the material is RAP

F. Select a ‘valid from date’ for the material

Material emissions value

Save and close new material
Plant Screen Operations

Creating a New Plant

Creating a plant involves the allocation of materials, transport, energy used in processing and energy used in heating and drying along with the definition of heating profiles and mixtures. Once you have created a plant, you will be able to see the emissions associated with each of the mixtures you produce.

Basic Data
This tab covers the initial information necessary to create a plant. It requires that you allocate a name, categorise the plant as ‘Continuous’ or ‘Batch’ and specify the total annual production of the plant in tonnes.

Figure 17 - Plant basic data
Electricity

Electricity used in the plant for processing the materials, in accordance with Protocol Section 2.7 and Appendix A. The tab operates in the same way as it does when allocating electricity usage for creating a material.

- Select the ‘Source’ from the drop down list
- Enter the annual ‘Amount’ of electricity used
- Click ‘Add’ to add the emissions to the plant

Other Fuel

Further energy consumption for sources other than electricity at the plant used for processing the material before heating and drying can also be added. The tab operates in the same way as it does when allocating other fuel usage for creating a material.

- Select the ‘Source’ from the drop down list
- Select the desired ‘Unit’ for the fuel being used
- Enter the annual ‘Amount’ of fuel used
- Click ‘Add’ to add the emissions to the plant
Water usage (optional)
This tab allows the allocation of water usage at the plant for the production of the asphalt. The criterion for this water usage is again set out in Protocol Section 2.7. This tab operates in a similar fashion to the previous ‘Electricity’ tab.
- Enter the annual ‘Amount’ of water used
- Click ‘Add’ to add the emissions to the plant
Energy used in the plant for heating and drying the materials into asphalt is done from this tab which operates in the same way as it does when allocating other fuel usage for creating a material.

- Select the **Source** from the drop down list
- Select the desired **Unit** for the fuel being used
- Enter the annual **Amount** of fuel used
- Click **Add** to add the emissions to the heating and drying energy for the plant

**Figure 20 - Plant water usage**

**Heating and Drying Energy Consumption**

Energy used in the plant for heating and drying the materials into asphalt is done from this tab which operates in the same way as it does when allocating other fuel usage for creating a material.

- Select the **Source** from the drop down list
- Select the desired **Unit** for the fuel being used
- Enter the annual **Amount** of fuel used
- Click **Add** to add the emissions to the heating and drying energy for the plant
Materials Transport to Plant
Materials used in the plant to create the mixtures need to have their transport to the plant considered. This tab allows materials and a number of transport steps to be added to the plant.

- Select the ‘Material’ from the drop down list
- Click ‘Add’ to associate the material into the plant
- Ensure that the correct material is highlighted on the list
- Select a ‘Mode of Transport’ from the drop down list
- Adjust the ‘Utilisation’ level for the mode of transport (default is 50%)
- Enter the ‘Outward Journey Distance’ in kilometres
- Adjust the ‘Hired Haulage’ percentage for the material (as appropriate)
- For some haulage transport modes, a return journey is not assumed. It can be selected by marking the ‘2 Way’ check box
- Click ‘Add’ to add the emissions for the transport leg to the material
Mixtures – Normal Process

Mixtures are defined at the plant by adding materials and entering details about the heating and drying process. This is implemented in accordance with Protocol Section 2.8.

- Enter a ‘name’ for the new mixture
- Click ‘Add New Mixture’ to create
- Ensure that the correct mixture is highlighted on the list
- Enter the tonnage of ‘Annual Production’ for the mixture
- Enter the ‘Production Rate’ (continuous) or ‘Heating Time’ (batch)
- Select a desired ‘Material’ to add to the mixture from the drop down list
- Enter the ‘Percentage’ of that material required in the mixture
- Click ‘Add’ to add the mixture to the plant
Only one bitumen component and one RAP component can be specified per mixture.

The Total Production (t) of the plant MUST be allocated between the defined mixtures; the plant cannot be saved if this is not the case.

Each mixture MUST have 100% of constituent materials defined; The mixture cannot be saved if this is not the case.
Mixtures – Special Process
To account for the potential use of novel technology and methods in the creation of mixtures, the ability to define a ‘special process’ is included in the software. This functions in a similar way to creating a normal mixture, but requires a number of further pieces of information to allow an equivalent production rate to be calculated. Further details can be found in Protocol Section 2.8.3.

- Enter a ‘name’ for the new mixture and
- Click ‘Add New Mixture’ to create
- Ensure that the correct mixture is highlighted on the list
- Enter the tonnage of ‘Annual Production’ for the mixture
- Check the ‘Calculate Production Rate from known process’ checkbox
- Enter the ‘Standard Process Energy’
- Enter the ‘Non-Standard Process Energy’
- Enter the ‘Standard Process Production Rate’
- Select a desired ‘Material’ to add to the mixture from the drop down list
- Enter the ‘Percentage’ of that material required in the mixture
- Click ‘Add’ to add the Mixture to the Plant

Figure 24 - Plant special mixture creation
Each mixture MUST have 100% of constituent materials defined; the mixture cannot be saved if this is not the case.

The Total Production (t) of the plant MUST be allocated between the defined mixtures; the plant cannot be saved if this is not the case.

**Energy Consumption Summary**
The final tab on the Plant Creator is for reviewing the consumables used at the plant. It provides a quick overview of the values that are being used to calculate the kgCO2e/t for the mixtures being created.

- If any of the values need changing, select the appropriate tab for the entry and edit the value as required.
- If the emissions are accurate, click 'OK' to save the new material to the database.

![Energy Consumption Summary Table](image)

**Figure 25 - Plant energy consumption summary**
Plant Report Summary

Clicking the ‘Report Summary’ button opens a new window with a customised report on the currently open plant. This report is in a PDF format and can be saved using the menu which appears when the mouse cursor is hovered over the bottom of the report window. The report includes a number of key features:

- Name, plant type and date
- Annual production tonnage and number of asphalt mixtures created and materials used
- Energy usage – total, processing and heating and drying breakdown
- Environmental impacts - total kg CO₂e and kg CO₂e/tonne
- Notes section – which includes important considerations and decisions made during the footprinting process. This includes:
  - Any special Processes specified for heating and drying

![Plant Summary Report](image)

Many plant can be created by duplicating the process described above.
Project Screen Operations

Creating a Project

By creating a project it is possible to complete the full lifecycle considerations of the road. Multiple mixtures and materials can be added to a project from different sources. Additionally, transport, energy used in laying and compacting, maintenance interventions, and energy used in excavating and disposal of the materials at the end of the roads life can all be specified.

Basic Data

This tab covers the initial information necessary to create a project. It requires that you allocate a name, provide a description and categorise the road as ‘Designed’ or ‘Evolved’. This categorisation is necessary to apply the appropriate lifetimes to asphalt courses in line with Protocol Section 2.12.

Navigate the ‘Project Editor’ via the tabs
A. Enter the desired name for the Project
B. Enter a description for the Project
C. Select the road type for the Project

Figure 27 - Project Basic Data
Material Transport to Site
To start creating a project it is first necessary to allocate the materials and asphalt mixtures to be used.

- If choosing a material, for site specific works, such as backfill or bond/tack coats, select '(None)' from the 'Plant' list and the required material from the 'Material'
- If choosing an asphalt mixture, select the required plant from the 'Plant' list and the asphalt mixtures produced by this plant will be available to select from the 'Material' list
- Click 'Add'

Next it is necessary to define the transport required to move the material or mixture from source to the project site. This section of the software works in the same way as the section that allows transport to be specified in the Plant Editor.

A. Select the Plant if choosing an asphalt mixture
B. Select the Mixture or Material
C. Select a mode of transport
D. Adjust the utilisation if required
E. Enter the outbound journey distance
F. Enter the percentage hired haulage

Right click to delete an entry
Click to add the material to the plant
Site Works Materials
"Direct to site" materials defined on the previous tab appear here so that the quantities used in the project can be specified.

- Select each material from the ‘Material’ list
- Enter the required tonnage of the selected material
- Click ‘Add’

**Asphalt Courses**
Asphalt mixtures selected on a previous tab are here assigned to an asphalt course and the required quantity for the project is entered. The type of courses that the mixtures can be assigned to varies depending on whether an ‘Evolved’ or ‘Designed’ road was specified when creating a project.

- Choose a mixture from the ‘Material’ list.
- Choose a type of course for the mixture from the ‘Course’ list
- Enter the tonnage for the mixture and course defined.
- Click ‘Add’

ONLY one mixture can be specified to the surface course per project.
Laying and Compacting

Energy used in the installation of the asphalt mixtures selected on the previous tab are defined here.

- Select either the 'Default' laying and compacting emissions or
- Select the 'Custom' checkbox and
- Enter the custom emissions associated with laying and compacting

Custom Laying and Compacting emissions figures must be calculated in accordance with Protocol Section 2.10

![Figure 30 – Specifying asphalt courses](image)
In-Situ Maintenance
This tab allows you to add maintenance interventions to extend the lifetime of the surface course.

- Select the type of surface ‘Treatment’ from the drop down list
- Enter the emissions for the treatment in ‘kgCO$_2$e/t’
- Enter the ‘Tonnage’ for the treatment selected
- Enter the ‘Additional Lifetime’
- Click ‘Add’ to assign the In-Situ Maintenance Treatment to the course

In-situ maintenance emissions figures must be calculated in accordance with Protocol Section 2.12.2
The Lifecycle Results tab presents a summary of tonnages and emissions figures by road course and gives an annualised emissions breakdown. This provides a basis to compare different mixtures on a life cycle basis.

Figure 32 - In-situ maintenance

Lifetime Results
The Lifecycle Results tab presents a summary of tonnages and emissions figures by road course and gives an annualised emissions breakdown. This provides a basis to compare different mixtures on a life cycle basis.
Excavation

Removal of the material at the end of life and the disposal/recycling of the excavated material can be either based on default values calculated from details about the planing operation or a custom figure can be used.

- Select the ‘Calculate from Default’ checkbox
- Select the ‘Width’ of the planing area
- Select the planing ‘Depth’ OR
- Select the ‘Use Custom Figure’ checkbox
- Enter the desired custom figure
- Allocate the percentage of excavated material between ‘stockpiled’ and ‘landfilled’
- Complete the transport sections for both stockpiling and landfilling options in the same way as on previous transport tabs
Custom Excavation emissions figures must be calculated in accordance with Protocol Section 2.13.2.

Select the source of the planing off energy emissions factor.

Click to add transport for material to the stockpile.

Click to add transport for material to the landfill.

Figure 34 – End-of-life processes
**Project Result Summary**
The Project Result Summary tab gives a breakdown of the kgCO₂e and kgCO₂e/t emissions of every step of the lifecycle as shown in Figure 2.

Subtotal figures are also given for:
- Steps 1 to 7 – Material acquisition to asphalt installation on site
- Asphalt – Material acquisition to excavation, excluding any direct to site/site specific works materials
- Project – Grand Total for the project

![Figure 35 - Project result summary](image)

**Detailed Mix Results**
The Detailed Mix Results tab gives a breakdown the kgCO₂e emissions of every asphalt mixture used in the project. The emissions associated with each mixture are given for:
• Steps 1 to 3 – Material acquisition, transport and processing
• Step 4 – Material transport to asphalt plant
• Step 5 – Asphalt production
• Step 6 – Asphalt transport to site
The total emissions and emissions per tonne of asphalt mixture are also shown.

![Figure 36 - Detailed mix results](image)

**Project Report Summary**
Clicking the ‘**Report Summary**’ button opens a new window with a customised report on the currently open project. This report is in a PDF format and can be saved using the menu which appears when the mouse cursor is hovered over the bottom of the report window. The report includes a number of key features:

- Name, description and date
- Numbers and quantities for both asphalt and site work materials
- Environmental impacts - Total kg CO₂e and asphalt kg CO₂e/t
- Notes section – which includes important considerations and decisions made during the footprinting process. This includes:
  - Use of non-default data for processes
  - Maintenance treatments specified
Any special processes specified for heating and drying

---

## asphaltCALC Project Summary Report

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Asphalt</strong></td>
<td><strong>Siteworks</strong></td>
</tr>
<tr>
<td>Number of courses: 0</td>
<td>Number of materials: 0</td>
</tr>
<tr>
<td>Tonnage in courses:</td>
<td>Tonnage of materials:</td>
</tr>
<tr>
<td>Total project tonnage:</td>
<td></td>
</tr>
</tbody>
</table>

## Environmental Impacts

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Total kg CO₂e:</td>
<td>Asphalt kg CO₂e / tonne:</td>
</tr>
</tbody>
</table>

**Notes:** None

**Disclaimer:** The data presented above is believed to be accurate and correct. It has however not been audited and no responsibility is held for errors resulting from misuse, misinterpretation or software failure.

This report has been produced using asphaltCALC. For more information please visit www.sabita.co.za

---

*Figure 37 - Project summary report*
Constants Screen Operations

Constants Forms

Constants can be edited when files with the .oaf extension are utilised. The default file extension is .acf; this can be changed by clicking save and selecting .oaf from the file type menu.

Clicking the Constants Icon from the main screen will reveal the window containing forms, as displayed in Figure 38 below.

There are four forms in total aligned to tabs. Each contains a set of constants that can be edited.

Editing Constants

Select one of the four tabs to edit a set of constants:

- Consumables – electricity, fuels, explosives and water.
- Transport – all transport modes and handling.
- Recycling and End-of-Life – the constants used in the asPECT Protocol Section 2.6 calculations and the recycled content/recyclability allocation can be modified here.
- Asphalt Courses – where aspirational design lifetimes can be altered.
Firstly locate the constant that you wish to edit. Then, moving across the screen from right to left, select the required unit and then specify the constant in the CO₂e conversion box. The default constant (as used in .acf files) is provided as a reference point. If you wish to restore the default constant then click the ”Restore Default” button. Any of the constants listed in the form can be edited (and restored).

Clicking the “save constants’ icon at the bottom right of the screen will close the screen. The specified constants will be utilised in all of the calculations throughout the remainder of the file, whether pre-existing or new.

If a file is opened that was created in a previous version of asPECT (pre-v3.1), then the constants file will initially display the original constants used when first opened as a .oaf file. If you choose to edit the constants file from here then the pre-2013 will be lost – clicking on ”restore default” will bring up a v3.1 default constant.
Appendix A

Transport Assumptions

To allow the user to make the most accurate estimations of road transport emissions the asPECT software has been built to include the utilisation factors of vehicles in the calculations. This approach calculates the emissions for the whole journey and for the whole load carried. It is then necessary to attribute the emissions per tonne of the material/mixture conveyed.

For each category of road haulage vehicle a “maximum payload” is used to apportion emissions per tonne. For each journey, the emissions will be reported in kgCO₂e/t. The table below gives the maximum payload for each category.

<table>
<thead>
<tr>
<th>Table 3 - Maximum payloads for road transport</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Payload (t)</td>
</tr>
<tr>
<td><strong>Rigid</strong></td>
</tr>
<tr>
<td>&gt;3.5-7.5t</td>
</tr>
<tr>
<td>&gt;7.5-17t</td>
</tr>
<tr>
<td>&gt;17t</td>
</tr>
<tr>
<td><strong>Articulated</strong></td>
</tr>
<tr>
<td>&gt;3.5-33t</td>
</tr>
<tr>
<td>&gt;33t</td>
</tr>
</tbody>
</table>

Should the maximum payloads not be representative of the journeys undertaken in a given assessment, lower payloads can be reflected by adjusting the utilisation factor (f). These constants can also be modified in .oaf files, by selecting the transport tab via the Constants Icon.